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ABOUT SMASHING MAGAZINE

Smashing Magazine is an online magazine dedicated to Web designers and 
developers worldwide. Its rigorous quality control and thorough editorial 
work has gathered a devoted community exceeding half a million 
subscribers, followers and fans. Each and every published article is carefully 
prepared, edited, reviewed and curated according to the high quality 
standards set in Smashing Magazine's own publishing policy. Smashing 
Magazine publishes articles on a daily basis with topics ranging from 
business, visual design, typography, front-end as well as back-end 
development, all the way to usability and user experience design. The 
magazine is — and always has been — a professional and independent 
online publication neither controlled nor influenced by any third parties, 
delivering content in the best interest of its readers. These guidelines are 
continually revised and updated to assure that the quality of the published 
content is never compromised.

ABOUT SMASHING MEDIA GMBH

Smashing Media GmbH is one of the world's leading online publishing 
companies in the field of Web design. Founded in 2009 by Sven Lennartz 
and Vitaly Friedman, the company's headquarters is situated in southern 
Germany, in the sunny city of Freiburg im Breisgau. Smashing Media's lead 
publication, Smashing Magazine, has gained worldwide attention since its 
emergence back in 2006, and is supported by the vast, global Smashing 
community and readership. Smashing Magazine had proven to be a 
trustworthy online source containing high quality articles on progressive 
design and coding techniques as well as recent developments in the Web 
design industry.
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About this eBook
With almost half of the smartphone market share, the iPhone is a concrete 
confirmation that it's worth it to be a vanguardist in technology. Designers 
that have familiarity with the Apple iOS are one step ahead in designing 
mobile interfaces. If you want do discover trends and special requirements 
that iPhone applications ask for, this eBook "Designing For iPhone" is a 
must.
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How To Create Your First iPhone 
Application
Jen Gordon

What if you had a nickle for every time you heard: “I have the perfect idea 
for a great application!“? It’s the buzz on the street. The iPhone has created 
unprecedented excitement and innovation from people both inside and 
outside the software development community. Still for those outside the 
development world, the process is a bit of a mystery.

This how-to guide is supposed to walk you through the steps to make your 
idea for an iPhone app a reality. This article presents various ideas, 
techniques, tips, and resources that may come in handy if you are planning 
on creating your first iPhone application.

You might be interested in the following related articles:

1. Have An Idea – A Good Idea
How do you know if your idea is a good one? The first step is to even care if 
your idea is solid; and the second step is to answer the question does it 
have at least one of the indicators of success?
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Does your app solve a unique problem? Before the light bulb 
was invented, somebody had to shout out “Man, reading by 
candlelight sucks!” Figure out what sucks, and how your app 
can make the life of its user more comfortable.

Does the app serve a specific niche? Though there aren’t any 
stats on the App Store search, the usage of applications is 
certainly growing with the explosion of App Store inventory. 
Find a niche with ardent fans (pet lovers, for example) and 
create an app that caters to a specific audience.

Does it make people laugh? This is a no-brainer. If you can 
come up with something funny, you are definitely on the right 
track and your idea may be the golden one. Heck, I hit a red 
“do not press” button for 5 minutes yesterday.

Are you building a better wheel? Are there existing successful 
apps that lack significant feature enhancements? Don’t be 
satisfied with just a wine list, give sommeliers a way to talk to 
their fans!

Will the app be highly interactive? Let’s face it, most of us have 
the attention span of a flea. Successful games and utilities 
engage the user by requiring action!

Action: Does your app fall in to one of these categories? If yes, it’s just about 
time to prepare the necessary tools.

2. Tools Checklist
Below is a list of items you’ll need (*starred items are required, the rest are 
nice-to-have’s):
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• join the Apple iPhone Developer Program ($99) *

• get iPhone or iPod Touch *

• get an Intel-based Mac computer with Mac OS X 10.5.5,

• prepare a Non-Disclosure Agreement (here’s a sample) *

• download and install the latest version of the iPhone SDK if you don’t 
already have it.

• a spiral bound notebook*

Action: Load up on your required supplies.
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3. What Are You Really Good At?
What skills do you bring to the table? Are you a designer whose brain 
objects to Objective C? A developer who can’t design their way out of a 
paper sack? Or maybe you are neither, but an individual with an idea you’d 
like to take to the market? Designing a successful iPhone application is a lot 
like starting a small business. You play the role of Researcher, Project 
Manager, Accountant, Information Architect, Designer, Developer, Marketer 
and Advertiser – all rolled into one.

Remember what all good entrepreneurs know – it takes a team to make a 
product successful. Don’t get me wrong, you certainly can do it all. But you 
can also waste a lot of time, energy and sanity in the process. Don’t go 
crazy, reference the checklist below and ask yourself: What roles are the 
best fit for you to lead? Then find other talented people to fill in the gaps. 
The infusion of additional ideas can only enrich the product!

SKILLS CHECKLIST

• Ability to Discern what works/doesn’t work in existing iPhone Apps

• Market research

• Outlining App Functionality (Sitemap Creation)

• Sketching

• GUI Design

• Programming (Objective C, Cocoa) (we assume here that we are 
creating a native application)

• App Promotion and Marketing
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Remember to have contractors sign your non-disclosure agreement. Having 
a contract in place tells your contractor “I’m a professional that takes my 
business and this project seriously. Now don’t go runnin’ off with this idea.”

Action: Select skills that are a good fit for you to lead. For those roles where 
you cannot lead, hire professionals.

4. Do Your Homework: Market Research
Market research is a fancy way of saying “Look at what other people are 
doing and don’t make the same mistakes.” Learn from the good, bad and 
ugly in the App Store. Coming up with creative solutions in the app concept 
development and design starts with analyzing other (maybe similar) 
applications. Even if you encounter a lot of poorly designed apps, your mind 
will reference these examples of what not to do.
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Action: Answer these questions:

• What problem does your app solve?

• What products have you seen that perform a similar task?

• How do successful apps present information to users?

• How can you build on what works and make it unique?

• What value does your app bring to your audience?

5. Know !e iPhone/iPod Touch UI
If you want to create an iPhone app, you need to understand the capabilities 
of the iPhone and its interface. Can you shoot a .45 caliber bullet out of your 
iPhone? No. Can you shoot videos? Yes!

The good news is that you don’t have to memorize the encyclopedic Apple 
User Interface Guidelines to get a feel for what works and what doesn’t in 
iPhone Apps. Download and play with as many apps as you can, and think 
about what functionality you want to include in your product.

Take note of:

• How do well-designed apps navigate from screen to screen?

• How do they organize information?

• How MUCH information do they present to the user?

• How do they take advantage of the iPhone’s unique characteristics: the 
accelerometer, swiping features, pinch, expand and rotate functions?
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Action: Download the Top 10 apps in every category and play with all of 
them. Review the Apple Guidelines for UI design and list at least 5 features 
you’d like to incorporate into your app.

6. Determine “Who Will Use Your App?”
We assume here that you’ve already determined that your app will bring 
value and that you will have a raging audience for your app. Well, fine, they 
are raging fans, but who are they really? What actions will they take to 
achieve their goals within the app?

If it’s a game, maybe they want to beat their high score. Or perhaps they are 
a first time player – how will their experience differ from someone who is 
getting a nice case of brain-rot playing your game all day?

If it’s a utility app, and your audience wants to find a coffee shop quickly, 
what actions will they take within the app to find that coffee shop? Where 
are they when they’re looking for coffee? Usually in the car! Do present an 
interface that requires multiple taps, reading and referencing a lot? Probably 
not! This is how thinking about how real-life intersects design.

Action: Line item out the different types of people who will use your app. 
You can even name them if you want to make the scenarios you draw out as 
real as possible.

7. Sketch Out Your Idea
And by “sketch” I mean literally sketch. Line out a 9-rectangle grid on an 8.5 
x 11 sheet of paper and get to sketching!

Ask yourself:
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• What information does each screen need to present?

• How can we take the user from point A to point B to point C?

• How should elements on the screen be proportioned or sized in relation 
to each other (i.e. is this thing even tap-able?)

Image credit: Cultured Code
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Thumbnailing your ideas on paper can push your creativity far beyond 
where your imagination might stagnate working in an sketching application! 
You can also buy the iPhone Stencil Kit to quickly sketch out iPhone UI 
prototypes on paper.

Action: Create at least one thumbnail page of your application per screen. 
Experiment with various navigational schemes, the text you put on buttons, 
and how screens connect. If you want to transfer your sketches into digital 
format, iPlotz is a good tool to check out.

8. Time For Design
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If you are a designer, download the iPhone GUI Photoshop template or our 
iPhone PSD Vector Kit. Both are collections of iPhone GUI elements that will 
save you a lot of time in getting started. If you’ve solidified your layout 
during sketching, drawing up the screens will be less of a layout exercise 
and more about the actual design of the app.

If you are not a designer, hire one! It’s like hiring an electrician to do 
electrical work. You can go to Home Depot and buy tools to try it yourself, 
but who wants to risk getting zapped? If you’ve followed steps 1–3, you’ll 
have everything you need for a designer to get started.

When looking for a designer, try to find someone who has experience 
designing for mobile devices. They may have some good feedback and 
suggested improvements for your sketches. A few places to look for 
designers: Coroflot, Crowdspring, eLance. When posting your job offer, be 
very specific about your requirements, and also be ready to review a lot of 
portfolios.

Action: If you are a designer, get started in Photoshop. If you are not a 
designer, start interviewing designers for your job.
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9. Programming

Even though this how-to is sequential, it’s a good idea to get a developer on 
board at the same time when you line up design resources. Talking with a 
developer sooner than later will help you scope out a project that is 
technically feasible and within your budget.

If you are a Objective C/Cocoa developer crack, open Xcode and get 
started! A few forums to join if you haven’t already:

• Apple Dev Forum

• iPhoneSDK (moderated by Erica Sadun)

• iPhoneSDKForum

• iPhoneDev Forums

• iPhoneSB
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If you are not a developer, you know what to do – find one! Specify the type 
of app you want to produce – whether it is a game, utility or anything else. 
Each type usually requires a different coding skill set. A few places to look 
for developers: Odesk, iPhoneFreelancer, eLance and any of the forums 
listed above.

10. Submit Your Application To Apple Store
OK, so how do you submit your application to Apple Store now? The 
process of compiling your application and publishing the binary for iTunes 
Connect can be difficult for anyone unfamiliar with XCode. If you are 
working with a developer, ask them to help you:

• Create your Certificates

• Define your App ID’s

• Create your Distribution Provisioning Profile

• Compile the application

• Upload to iTunes Connect

Action: If you are a developer, map out a development timeline and get 
started. If you are not a developer, start interviewing devs for your job.
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11. Promote Your App
If a tree falls in the middle of the woods and nobody was around to hear it 
does it make a sound? Apps can sit in the store unnoticed very easily. Don’t 
let this happen to you. Be ready with a plan to market your app. In fact, be 
ready with many plans to market your app. Be ready to experiment, some 
ideas will work, others won’t.

STRATEGIES FOR MAINTAINING/BOOSTING APP SALES:

• Incorporating social media. If your users make the high score on his or 
her favorite game, it is a good idea to make it easy for the user to post it 
to Facebook or Twitter. Think about how your app can incorporate 
social media and build that functionality into your app. At a minimum, set 
up a fan page for your app on Facebook and Twitter and use them as 
platforms to communicate with your users and get feedback on your 
app.

• Pre-launch promotion. Start building buzz about your app before it has 
launched. E-mail people who write about things that relate to your app 
and see if they will talk up the upcoming release of your app.

• Plan for multiple releases. Don’t pack your app with every single 
feature you want to offer in the very first release. Make your dream list 
for the app and make sure that the app is designed to incorporate all of 
the features at some time in the future. Then periodically drop new 
versions of the app to boost app store sales.
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Action: Make a list of 20 promotional strategies that target the audience for 
your app. Take action on them yourself or hire someone who can!

12. Stay Focused & Don’t Give Up!
It’s easy when you are working on your first app to get all AppHappy, 
dreaming up a zillion new app-ideas. Dream, but don’t get sidetracked by 
new ideas. Your first app needs to make a big splash and getting involved in 
too many projects at once can dilute your passion for making your first 
application a success.

Action: Get out there and go kick some app!
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Web Development For !e iPhone And 
iPad: Ge"ing Started
Nick Francis

According to AdMob, the iPhone operating system makes up 50% of the 
worldwide smartphone market, with the next-highest OS being Android at 
24%. Sales projections for the Apple iPad run anywhere from one to four 
million units in the first year. Like it or not, the iPhone OS, and Safari in 
particular, have become a force to be reckoned with for Web developers. If 
you haven’t already, it’s time to dive in and familiarize yourself with the tools 
required to optimize websites and Web applications for this OS.

Thankfully, Safari on iPhone OS is a really great browser. Just like Safari 4 
for the desktop, it has great CSS3 and HTML5 support. It also has some slick 
interface elements right out of the box, which sometimes vary between the 
iPhone and iPad. Lastly, because the iPhone OS has been around for quite 
some time now, a lot of resources are available.

I know that most discussion about the iPhone OS platform centers on native 
applications. But you can still create powerful, native-looking applications 
using HTML, JavaScript and CSS. This article focuses on three phases of 
building and optimizing your website: design, coding and testing.

Before we get into the three phases, let’s look at some of the advantages 
and disadvantages of building a Web app rather than a native app.

Advantages of building a Web app instead of a native app:

1. No Apple approval process or red tape, which is especially important 
given the terms of service dispute going on right now.
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2. Optimizing your Web app for other popular platforms like Android and 
Blackberry with the same code is much easier.

3. You don’t have to learn Objective-C.

4. If you’re charging users, you don’t have to share revenue with Apple.

5. You get 100% control over the means of payment, promotion and 
distribution to users… which could also be a negative, depending on 
how you look at it.

Disadvantages of building a Web app instead of a native app:

1. No presence in the App Store.

2. Installing the app on a device is a little trickier.

3. No access to some of the features that are native to the iPhone OS, 
such as push notification and GUI controls.
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Design
Designing a Web app for this platform is much like designing a native app, 
so you’ll have access to some really great tools. Whether your wireframing 
tool of choice is pencil and paper or desktop software, you’re covered.

INSPIRATION

Not many people know that Apple has a “Web apps” section on its website, 
which is dedicated to showcasing optimized websites.

Featured Web app on the Apple website
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There are also some galleries elsewhere that showcase the finest in mobile 
Web design:

• Apple Web Apps Listing

• Mobile Awesomeness Design Gallery

• CSS iPhone Design Gallery

• Well Placed Pixels

• Apple App Store (Even though these are native apps, you can find great 
visual inspiration here.)
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PAPER

Paper prototyping has long been my tool of choice for wireframing new 
ideas or websites. What I really like about the tools below is that they 
provide perspective on the size and dimensional constraints that you’re 
dealing with. To successfully optimize a Web app for the iPhone OS, you 
have to cut things out. I suggest keeping the design minimal by wireframing 
with a sharpie and one of the tools listed below.

Notepod is great for sketching out rough ideas for the iPhone and iPad.

• Notepod: iPad and iPhone sketchbooks

• App Sketchbook
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• PixelPads

• UI Stencils sticky pads

• Apress iPhone Application Sketch Book

• Printable iPhone Wireframe Template (free)

DIGITAL

Once you know exactly how things will lay out in your design, we can move 
to the desktop and get specific. I really like wireframing with OmniGraffle, 
but sometimes diving straight into Photoshop makes sense. Either way, 
these tools are a huge help in making it happen.

iPad GUI preview from Teehan + Lax.

• iPhone GUI PSD 3.0 and iPad GUI PSD (Photoshop)
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• Layered iPhone GUI elements (Photoshop), from Designer’s Toolbox

• PSD Vector Kit (Photoshop), from Smashing Magazine

• iPad and iPhone stencils; see more at Graffletopia (OmniGraffle)

• iPhone and iPad Development GUI Kits, Stencils and Icons

Hungry for more? This article has a good rundown of additional design tools.

Coding
When you start coding for Safari on the iPhone OS, understanding how the 
browser works is important. Also, there are subtle differences in the iPhone 
and iPad’s browsers, such as how form-select boxes work. Most importantly, 
Safari has great CSS3 and HTML5 support, so you can use modern code 
without having to worry about cross-browser compatibility.

EDUCATION

Apple actually does a really good job of documenting Safari for the iPhone 
OS. The only shortcomings in my opinion are a lack of help with browser 
detection and window orientation. Read each of the articles below for 
everything you need to know about coding for this browser.
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iPhone Human Interface Guidelines for Web Applications
This is a good overall summary of how Safari for the iPhone OS works. It’s 
certainly worth scanning through, because it has some good advice, 
although no specific coding examples.

iPad Human Interface Guidelines
This document does a good job of distinguishing iPhone elements and iPad 
elements. This is also worth scanning through, because it has some great 
advice on designing for the iPad.

Safari Web Content Guide
This document gets specific about the viewport, webclip icons, unique meta 
tags and event handling, among many other topics. Code examples are 
provided. I recommend reading it cover to cover before getting started.

Preparing Your Web Content for the iPad
This document provides tips on testing your website on the iPad, but its 
discussion on browser detection isn’t as detailed as I would like.

Browser Detection
David Walsh provides good examples of proper browser detection for the 
iPad and for the iPhone on his blog. Options for PHP and Javascript are 
included.

Detecting iPhone Window Orientation
This iPhone development tutorial from Nettuts provides a good example of 
how to vary style sheets according to the iPhone’s orientation.

Detecting iPad Window Orientation
Detecting iPad’s window orientation is much easier. Here’s what the code 
looks like (no JavaScript required):

<link rel="stylesheet" media="all and (orientation:portrait)" 
href="portrait.css">
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<link rel="stylesheet" media="all and (orientation:landscape)" 
href="landscape.css">

JQTOUCH MOBILE FRAMEWORK

While the iPhone has a few mobile development frameworks, jQTouch is far 
and away the best. jQTouch gives you all of the tools to make your mobile 
Web app look and feel like a native one. Visit the website, and go to the 
demo website from your iPhone to get a feel for it.

My only complaint when building my first website with jQTouch was a lack of 
documentation and tutorials. I had to figure it out by playing with the demo 
website’s code. Here are some jQTouch articles that proved helpful in 
coding my first website:

• jQTouch Wiki on Google Code

Smashing eBook #30│Designing for iPhone│ 27

http://jqtouch.com/
http://jqtouch.com/
http://jqtouch.com/preview/demos/main/
http://jqtouch.com/preview/demos/main/
http://code.google.com/p/jqtouch/wiki/GettingStarted
http://code.google.com/p/jqtouch/wiki/GettingStarted


• Building iPhone Apps with HTML, CSS and JavaScript, Chapter 4: 
Animation

• PDF slides about getting started with jQTouch, by Philipp Bosch

Testing
A crucial and somewhat tricky part of building a website or Web app for the 
iPhone OS is testing. It’s a little more complicated than testing in a web 
browser, but familiarizing yourself with a couple of tools should make the 
process simple.

LIVEVIEW
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Liveview is a really clever testing tool for when your app is in the design or 
initial coding phase. It allows you to broadcast an image from your desktop 
onto your phone so that you can see what it looks like. This is useful for 
getting text size and the visual specifics just right, because sometimes 
visualizing from Photoshop is hard.

USING THE IPHONE SIMULATOR

In my opinion, no good iPhone or iPad emulators are available. The ones 
that are available are a waste of time. Much better is to download the latest 
version of the SDK and use Apple’s official iPhone OS simulator, which of 
course supports the iPad as well.

Setting up the SDK and a local testing environment takes a few minutes but 
is well worth the effort, rather than depending on unofficial and often 
inaccurate emulators. I’ve written a step-by-step tutorial about setting up a 
local testing environment that’s worth a read. One great thing about local 
testing is that it’s faster and does not require an Internet connection. I highly 
recommend going this route until you are ready to launch.

PhoneGap: Best Of Both Worlds?
PhoneGap is a game-changer for Web developers. If you would rather 
create your app in HTML, CSS and JavaScript but want it to run natively and 
have it be available in the App Store, then PhoneGap is the solution. It’s an 
open-source development tool that not only compiles your code for native 
use on the iPhone OS but also works for Android, Palm, Symbian, Windows 
Mobile and Blackberry devices.
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PhoneGap also steers clear of the recently controversial 3.3.1 clause of 
Apple’s terms of service. In other words, apps compiled with PhoneGap will 
still be approved. Check out the list of apps that are built with PhoneGap to 
learn more.

Feeling Overwhelmed?
If you are, then some good hosted services will make it easier to optimize 
your website for multiple platforms without having to start from scratch. 
There are various levels of flexibility available, but all the services use a 
WYSIWYG-like editor to help you create mobile websites on the fly. 
Depending on your Web app and client, one of the following may be a good 
fit:
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Mobify is a great alternative if you don’t care to build from scratch.

• Mobify (which powers Smashing Magazine’s mobile website)

• Wapple

• Mofuse

• Mobi10
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Conclusion
It’s a great day to be a Web developer, because non-desktop platforms like 
the iPhone OS open up greater possibilities for us to express our creativity 
and entrepreneurial savvy, while allowing us to adhere to modern Web 
standards. All of the tools you need to create great a Web experience on the 
platform that’s currently dominating the mobile space are out there. It’s up to 
you to make the most of them!
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iPhone App Design Trends
Jen Gordon

For the past two years, the elegant iPhone has housed some of the most 
poorly designed applications you could imagine. The hype surrounding 
iPhone has prompted many designers across the globe to try their skills with 
the new mobile medium. The result are literally thousands of various iPhone-
applications that are often hardly usable and counter-intuitive. However, 
some designers invest a lot of time and efforts into creating usable and 
original user interfaces (yes, there are usable and creative UIs).

This article explores the ways in which designers use graphical elements 
and screen interactions to create iPhone-applications that are easy on the 
eyes and mind. The aim of this article is to display common trends and 
design approaches in iPhone app design – please notice that they are not 
necessarily optimal ones from the design or usability point of view.

1. Mirroring Native iPhone UI Elements
“Tell them what you’re gonna tell them, tell them, and then tell them what 
you told them.” Creating a whole new OS within your app can be fun, but 
when you’re dealing with the mobile medium, people just want to get stuff 
done. Getting stuff done means that the designer has to get into the flow of 
the OS and create an app that requires zero explanation for the end user to 
operate. Mirroring the layout and UI elements that the user is already familiar 
with saves time and energy. So it seems quite convenient to use this 
approach when designing iPhone-applications.
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Facebook (iTunes Link)
In the new Facebook 3.0, you’ll find a grid layout that users can swipe left 
and right to access more categories. Because it mirrors Apple’s native UI, 
users do not have to “learn” how to use it all over again. A similar approach 
exists in Web design: users expect to see a logo in the top left, navigation 
along the top, etc. Facebook has taken this concept mobile, using large 
buttons that are easily distinguishable and tap-able.
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Where (iTunes link)
Where has a similar concept, allowing users to swipe left and right to access 
more data.
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Tweetdeck [iTunes link]
Tweetdeck is a good example of user interface design on many levels. 
Notice how the design highlights recent updates. The application could 
display the updates in a new window, with a categorized or tabbed list. But it 
doesn’t. Instead, a more familiar dialogue menu is displayed — it serves as a 
springboard to jump to a specific category or to clear the messages 
altogether.
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2. Simplifying !e Interface
Simplifying user interfaces may sound like a mechanical task, but what lies 
beneath the surface of user interface design? The answer is simple: users. 
And what do users want? What makes them all warm and fuzzy? How do 
you deliver what they want so that they don’t even notice how they are 
consuming information?

Facebook’s first release did a great job of fitting a lot of core functionality 
into a small space. The problem, of course, is in laying out all that data and 
creating an intuitive interface. Compare 3.0 with the first release, and you’ll 
see how they took a “springboard” approach to streamlining the interface, 
keeping it intuitive and maintaining functionality.
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Flickr [iTunes link]
Flickr is another example of how to achieve a good balance between 
functionality, visual design and the small display area on mobile devices. 
Think about it: what is at the core of Flickr? Photos. Its users probably do not 
want to look at big clunky navigational elements; instead, they are looking 
for pictures. Flickr has managed to fit all of its core functionality without 
heading down the highway to navigational hell. In fact, most elements in the 
navigation are handled by interacting with the photos themselves. Simple 
and smart.
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3. Hardware-ish Look
Many utilities are breaking out of the conventional iPhone UI to take 
advantage of the device’s unique ability to respond to finger gestures. Many 
of these have hardware-ish interfaces that users are familiar with but come 
with perpetually shiny exteriors and clicks and pops that maintain their 
newness from the first to one-thousandth click. Next up, though: an app that 
gets dirtier the more you play with it.

Smashing eBook #30│Designing for iPhone│ 41



Convertbot (iTunes link)
Convertbot reminds us of the proportion wheel we all used in grade school, 
except it’s more distinctive, original and creative.
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Little Snapper (iTunes Link)
Little Snapper mimics the wheel that you turn on a typical digital SLR.
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iHandy Level (iTunes Link)
iHandy Level simulates the look and functionality of a real, well-used leveler.
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Where To? [iTunes Link]
This application looks like it belongs in a Mercedes. Plush leather, matte-
finish tactile buttons: quality craftsmanship. We can just imagine how each 
button press feels solid, requiring the perfect amount of pressure.
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4. Rich, Padded And Pre"y List Views
You know that you are a geek designer when you get excited about the 
latest trends in list view design. And what do people do when they 
encounter a list view? Of course, they skim. And how do we make it easier 
for people to decide what interests them? That’s right: more visual cues!

Essentially, users are asking for a snapshot of what’s next, and then decide if 
they want more information. One way to do this is with big pretty buttons. 
Large and in charge, elegantly designed big buttons give the user a lot of 
information through their color, icons and typography.
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Delivery Status Touch (iTunes Link)
Check out how Delivery Status uses appropriate colors on its big buttons to 
identify each brand. And it uses typography well to establish a hierarchy of 
information.
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Be Happy Now (iTunes Link)
Be Happy Now’s big buttons convey the “be happy” mantra through a 
mellow color scheme and light, calm and clear typeface.

Smashing eBook #30│Designing for iPhone│ 48

http://www.mentalworkout.com/products/iphone-applications/be-happy-now/
http://www.mentalworkout.com/products/iphone-applications/be-happy-now/
http://click.linksynergy.com/fs-bin/stat?id=u73nf2nX9kU&offerid=146261&type=3&subid=0&tmpid=1826&RD_PARM1=http%253A%252F%252Fitunes.apple.com%252FWebObjects%252FMZStore.woa%252Fwa%252FviewSoftware%253Fid%253D321896701%2526mt%253D8%2526uo%253D6%2526partnerId%253D30
http://click.linksynergy.com/fs-bin/stat?id=u73nf2nX9kU&offerid=146261&type=3&subid=0&tmpid=1826&RD_PARM1=http%253A%252F%252Fitunes.apple.com%252FWebObjects%252FMZStore.woa%252Fwa%252FviewSoftware%253Fid%253D321896701%2526mt%253D8%2526uo%253D6%2526partnerId%253D30


Next Read [iTunes link]
The Next Read application allows friends to share books. Here all books 
about a particular topic are presented, including the title, cover image, 
review rating and number of people who have recommended it. Notice the 
padding and a lot of white space for each navigation option; this makes the 
areas easily clickable and easier to navigate.
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Nike [iTunes link]
Nike’s workout application for women includes a nice visual treatment and 
illustrations that match the brand. It breaks out of the traditional UI just 
enough to communicate the brand without making it difficult for users to 
understand the interface and how to use it.
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Borange [iTunes link]
Borange is a “social availability” application that helps you coordinate 
meetings with friends. The list view presents a lot of information: friends you 
want to hang out with, the meeting location and a nice visualization of 
friends who are available.
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5. Layered Interface
Several applications take advantage of the iPhone’s capabilities by layering 
the interface and making some elements stationary and others vertically or 
horizontally scrollable. This approach has several benefits:

1. It reduces the number of traditional navigation elements that are 
necessary (i.e. fewer buttons help to avoid a cluttered interface).

2. It gives users a faster route to the information they want.

3. More screen space is available for information.

Smashing eBook #30│Designing for iPhone│ 52



Tweetie (iTunes Link)
Tweetie uses layers to organize information specific to each of your Twitter 
friends. Just look at all of the information packed into this one screen!
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Barnes & Noble [iTunes link]
Barnes & Noble has a layered interface that allows you to quickly slide 
through new releases at the top or dive into more categories below.
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USA Today [iTunes link]
USA Today takes a slightly different approach to layering the interface in its 
“Pictures” section: it uses sliding panels to display blocks of information. 
While the interface may look cluttered at the first glance, one can easily get 
around it. The interesting part is that within each panel you can slide 
thumbnails left and right to view more images.
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myPantone [iTunes link]
Would we expect any less from Pantone? The color picker shown above is a 
layered interface that lets you pick from a range of colors, sort and scroll as 
well as open and close detail screens, all without too driving you crazy.
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iPhone App Design Trends - Part II

6. Icons For !e List View
Icons aren’t just for springboard-loving folks. On small screens, icons can 
give a huge boost to an application’s usability and navigation. Let’s now take 
a look at some examples of applications that use icons to their advantage.

iStudiez (iTunes Link)
This application uses various educational metaphors as icons to clearly 
communicate the purpose of the application. Excellent visual cues tell the 
student what’s happening today at a glance.
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Top Floor (iTunes Link)
Top Floor uses simple and easily recognizable icons to quickly guide users 
to their category of choice.
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New York Times
Isn’t it great when applications just let you do whatever you want to do? For 
an app with as much information as the New York Times’, users are bound 
to have their favorite sections. Well, guess what? The New York Times 
cares: it lets you customize the tab bar’s navigation to include only your 
favorite sections of the paper. Drag an icon down the tab bar and you are 
set. The downside of the design is, of course, its lack of visual appeal.
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Filemaker [iTunes link]
Here is another example of beautiful icons that aren’t obscure or confusing. 
Designers should never use icons just for the sake of having icons. As 
designers, we want icons that illustrate what users are actually going to get 
when they choose a particular path. Nicely done, Filemaker.
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7. Illustrations in use
Applications that rely on graphics not found in the standard user interfaces 
are increasing in popularity, as developers try to set their apps apart from 
the crowd. Sometimes it works, but often it doesn’t. The more 
unconventional a design is, the more likely it is to have usability problems. 
Please always conduct usability testing before releasing a product with a 
“creative” user interface.
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Magnetic Personalities (iTunes link)
An excellent example of how buttons don’t have to look like standard 
buttons.
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SugarSync [iTunes link]
This interface could have easily followed the traditional list-view route. 
Instead, the designers played with the concept of “connectivity” to create a 
visual treatment that communicates the purpose of the app. It is unusual and 
requires some time to get used to.
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Mom Maps [iTunes link]
Another example of how illustrations do a great job of pulling together the 
whole concept of an application.
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8. Using Gestures
Classic linear navigation may look boring: a button that links to other 
buttons, which leads you to a list of something, which leads you to such-and-
such an interaction. Not really spectacular. The possibilities for creative 
interaction in utility apps are huge and largely untapped (no pun intended).
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Mover (iTunes link)
Mover exemplifies how to use gestures for sharing contacts, photos and 
bookmarks. Open two devices, and flick the shared files from one handset 
to the other.
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ABC Animals [iTunes link] 
This application teaches while it entertains. Being able to trace a letter with 
your finger is another example of how the iPhone responds to touch and 
movement.
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All Recipes [iTunes link]
This applications allows you to mix in various elements to create your next 
meal using gestures.
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iPhone App Designs Reviewed: Critique 
Board And Lessons Learned
Alex Komarov

Some time ago I started a mobile app design review section on our 
company’s website. The idea behind this “Crit Board” was simple: if mobile 
developers want to create apps that people want to buy, they’ll need help 
with design and usability. But most of the time they can’t afford it. On our Crit 
Board, developers can send us their mobile apps (iPhone apps, Android 
apps, Blackberry apps) along with questions and problems, and we (free of 
charge) will pick apart key usability issues, illustrate our design 
recommendations and post our findings.
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The only condition to get free criticism from us is that you agree for it to be 
made public, which is why I am able to share several case studies with 
Smashing’s readers right now. It’s hard to imagine something more relevant: 
these are real problems facing real developers. I hope these problems and 
the proposed solutions will benefit others who have similar issues and will 
be generally relevant to those working in the field.

1. Foobi
“Alex,
I am the lead designer and developer of Foobi. Foobi was designed to track 
your diet in a different way; instead of tracking calories and tapping on 
many drilled-down lists, it works by simply tracking servings per food group 
and providing an overview of your food intake balance.
Although I have tried really hard not to over-design it by tracing Apple’s 
footsteps while building custom UI control elements, I would love to hear 
from you about this subject.
— Remy”
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Your app is beautiful indeed. And it is also usable and easy, exactly as you 
describe it: if user knows how to flick, he is already an expert. An expert in 
what, though?

As stated in the iTunes description, the purpose of this app is to “track and 
balance your diet.” I understand the two main user goals as follows:

1. To record what food they consume,

2. To make sure they stay on the right path with their nutrition, and to 
have a clear guide to balancing their diet if they veer off that path.
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Your app does a good job of fulfilling the first goal: users can easily record 
what they eat just by selecting the right food group and adding the amount 
of “servings” consumed.
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But what about the second more important goal of tracking progress and 
adjusting one’s diet? Does the app help customers achieve this goal? Not 
very well. There is room for big improvement.

There are two main problems with this part of the app.

SUMMARY INFORMATION IS HIDDEN

To access the summary chart, you have to flip the iPhone to the side and 
view it in landscape mode. But this feature is not communicated through the 
app’s design, so a user will discover it only by accident. When we talk about 
fulfilling a major user goal, it is important never to rely on accidents to 
communicate functionality.
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SUMMARY INFORMATION IS NOT WELL DESIGNED

Additionally, the summary is not informative enough.

The summary chart doesn’t offer too much to the viewer. Here are the main 
problems:

• It’s not clear what the different colors mean, and there is no legend to 
help.

• The scale is not flexible. You can view the information only by week, 
which does not allow users to easily see their big-picture eating habits. 
(Tip: consider incorporating the pinch gesture to allow users to scale in 
and out.)

• Tracking consumption of a particular food group is not possible with this 
chart but would be valuable to users.
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Information design is a vast topic. There are a million ways to address the 
problems that I’ve highlighted and to increase the visibility of useful 
information for your audience. I recommend reading Edward Tufte’s books, 
particularly The Visual Display of Qualitative Information.

And here’s an inspiring display of a lot of information. Of course, it’s not 
tailored to mobile use, but it has a few great ideas:

From Google Finance.
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ONE MORE THING

When I purchased and downloaded your app, I didn’t quite understand why 
it was taking so long to download… until I realized that it had already 
downloaded. I was fooled by the app icon, which makes it look like it is still 
downloading:

2. Budget Planner
“Alex, please take a look at my app Budget Planner. I have tried everything, 
and it keeps going up and down. The major issues that people complain 
about are intuitiveness and slowness. People don’t understand what the 
software does. But people who do learn it love it.
— Alex Sabonge”
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The basic idea of this app is very good, and the App Store description 
shows off its functionality well:”Budget Planner tracks your bills, budget, 
calendar and transactions by displaying your balance in a calendar view, 
letting you know how much money you will actually have on any particular 
day. Like a balance forecaster.”

Here’s an overview of how Budget Planner works:

Users input their monthly salary info and plug in their fixed monthly expenses 
(utilities, phone, car payment, etc).
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Using this data, the app allows users to track their cash flow and predict the 
amount they’ll have in the bank on any given day.
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Most folks would find this extremely useful. So, why are people complaining 
about the app? Why does it have an average rating of 2.5 out of 5 stars, and 
why are sales lower than you had hoped?

Let’s look at the main sources of the problem. For now, we’ll set aside lesser 
(though important) usability factors, such as not following the iPhone UI 
guidelines and using the standard controls improperly. Let’s start at the 
beginning. Humans invented money to buy things, right? Your core 
audience’s main goal is to know what they can afford and when they can 
afford it, whether it’s a new pair of shoes, a new car or a solid retirement 
plan.

People don’t prepare a budget just for fun. They make the effort because 
they hope it will help them make better purchasing decisions (read: buy 
more stuff that they like), without their rent check bouncing. Your app is 
getting there. But several key factors are getting in the way of a great user 
experience. Let’s take a closer look at the app’s “landing screen,” the 
calendar, the main element that differentiates this app from other budget 
apps.

First of all, I think the calendar is a great idea. It’s much better than the 
categorized lists that many other apps have. The calendar is all about how 
much money you have or will have in future. A list only shows how much 
you’ve spent. Knowing that your money is gone doesn’t really help achieve 
a financial goal (purchasing a shiny new laptop, for example).

Here are some downsides to the calendar view:
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I believe there’s a way to visualize information in the current design so that 
users are able to uncover “invisible” patterns. Uncovering the details and 
patterns behind their spending habits enables users to get new ideas, make 
informed decisions and achieve their financial goals (and praise your app in 
the process). Users will better understand their bad habits and be able to 
take steps to correct them.

A graph could provide richer possibilities for visualizing financial information. 
It’s much more flexible and scalable then a calendar. Using a graph for the 
landing screen could dramatically increase the density of meaningful data, 
while reducing visual noise. Here are some ideas we came up with; this is 
merely a draft we put together to illustrate our points and to get your ideas 
flowing—it is not a proposal for a final design:
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NEXT STEPS

People love apps that help them achieve their goals. What if your app 
allowed users to input and compare different financial scenarios, shown 
through several overlaid graphs?

This capability could help users think through their options:

• If I put my child through this private school, would I still be able to afford 
the Beemer I’ve always dreamed of?

• How many hours of overtime would I need to work to be able to afford 
both?

These are few examples of questions that people ask themselves. If your 
app can help them get the answers, I think it’ll really catch on, and you’ll 
soon be driving a shiny new Beemer yourself.

3. UNITS UNITED

“Unit conversion app, Units United. Yep, yet another one… ;) Can you please 
review it?
— Meils Dühnforth”
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The biggest problem with almost every unit converter I have seen is that 
they require users to submit their query in a format that the computer (or 
iPhone in this case) can understand. Most unit converters force people to 
make double the effort to get what they want.

Consider the following scenario: you’re from the US, and you are recounting 
yesterday’s baseball game to your Icelandic friend. During their last at bat, 
the Phillies hit a 456-foot home run. Amazing! You punch the value into your 
unit converter app, but to get an answer you must translate the query into a 
format that the application understands:

1. Go to “Categories,”

2. Select meters for the “To” unit,

3. Select feet for the “From” unit,

4. Type in 456 on the number pad,

5. Double-check that you are converting 456 feet into meters and not vice 
versa.
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Are all these steps necessary? You just wanted to know “What is 456 feet in 
meters?” But you had to ask the question in robo-speak. You had to select 
options from a list to be understood. Good software speaks your language. 
Among the innumerable unit converters, only Google does it right, allowing 
you to ask your question in plain English:

Using speech recognition technology is another good idea. Sometimes your 
hands aren’t free when you need to convert a unit. Say your Icelandic friend 
is driving on a US highway and needs to convert the 55 miles-per-hour 
speed limit into kilometers.

Implementing everything described above, your app might look something 
like this (this quick draft is meant to illustrate the point and is not a design 
proposal):
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This application is much easier to use because there’s no more robo-talk: it 
doesn’t force users to browse categories and sub-categories, and it accepts 
questions in everyday language.

Send Your App For A Free Review!
Mobile developers are always welcome to send me their apps for a free 
review. Just use this form. Please remember that your content will be 
featured on our Crit Board, allowing developers, designers and users 
worldwide to join the conversation. If you prefer to speak privately about 
your design, please feel free to contact us directly.
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iPhone Apps Design Mistakes: Over-
Blown Visuals
Alex Komarov

The development of iPhone applications has recently become a hot topic in 
the design community; everybody tries to come up with some creative idea, 
port it into a stylish iPhone-alike application and sell it to thousands of users 
through the iPhone app store. However, many of these applications are 
poorly designed and therefore miss the chance of providing users with a 
truly useful product that users would find worth recommending to friends 
and colleagues.

We want to take a closer look at the design of iPhone applications and 
showcase some good and bad examples, best practices as well as useful 
ideas and recommendations for your next iPhone app design. This article is 
a first of a new series related to the design of iPhone applications. Are 
iPhone apps really not good enough?

“It’s only 99 cents. Who cares if it sucks? I’m still trying it.” How many times 
have you said something like that to yourself before downloading the next 
promising iPhone app? How many screen-fulls of those apps do you have on 
your iPhone? 4? 6? 10? And how many of them do you actually use?

On average, only 3% of people who have downloaded an app use it after 30 
days. Why? Because the majority of iPhone apps don’t make any sense to 
users. The situation is similar to that of PC software a couple of decades 
ago. Have we not learned from our mistakes?
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iPhone applications nowadays are designed by developers who seem to 
care only about their app’s implementation. When an app goes live, its 
beautiful code or visual design often fail to address real customers’ needs. 
The result: thousands of useless applications in the App Store that people 
download and use once and then never again. These applications often 
don’t make sense to customers because of a poor interaction design.

Free applications usage over time: Percentage of users returning versus number 
of days since first used. On second day, 20% returning users; on the 30th day, 
only 3%. By Pinch Media. Larger image.
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Paid applications usage over time: Percentage of users returning versus number 
of days since first used. It’s not really different from the graph above. Paid 
applications generally retain their users longer than free applications, although 
the drop-off is still pretty steep. By Pinch Media. Larger image.
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Users stop using the average applications pretty quickly. Long-term audiences 
are generally 1% of total downloads. By Pinch Media. Larger image.
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Hilarious 500 million downloads breakdown, by Gizmodo. Larger version 
(Copyright: Gizmodo)
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It shouldn’t be this way. Developers should be writing applications that 
people love so much that they would pay $9.99 or even $99.99 for each of 
them. There’s no programming technique that teaches you how to do this. 
But there is something else, and it’s called interactive design.

Five Most Frequent iPhone Design Mistakes
Many applications share the same design problems that prevent customers 
from fully enjoying them. Recently, I conducted a review of 100 apps from 
the App Store and identified the five most frequent iPhone design and 
usability mistakes, which are:

1. Over-blown visuals.

2. Neglecting technological limitations, such as slow Internet connection, 
slow processors and single-threaded OS architectures.

3. Confusing navigation (flow, layout and taxonomy).

4. Confusing the iPhone with a computer. Neglecting to use new iPhone 
interactions (fingers instead of the mouse; multi-touch gestures; turn, tilt 
and rotate) and technological features such as phone functions, built-in 
GPS and accelerometer.

5. Disregard of context. A lack of understanding of how, when, where and 
why the mobile device is being used.
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Let’s start with the first one in this article and proceed with the next ones in 
the follow-ups to this article.

Mistake #1. Over-Blown Visuals
Probably the oldest, yet extremely popular design problem is overdesign. 
Designers of iPhone applications often tend to disregard common design 
and usability conventions by offering users slick and shiny user interface 
designs that go way beyond their standard look and also way beyond their 
claimed functionality.

Why make things look, feel and work complicated and why do designers like 
to re-invent the wheel? The answer is simple: they want the application to be 
different; look different and stand out from the crowd. Unfortunately, a 
different look isn’t necessarily helpful for application’s usability and 
functionality.

So how does an over-design in iPhone applications look like? To better 
understand it, let’s look at an example:
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Motion X GPS settings.
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What do you think is wrong with the design in this first screenshot? Some of 
you may say, “Well, nothing is really wrong with it. It’s beautiful.” I agree, it’s 
pretty slick. But, there’s a catch: while beautiful, it is also inconsistent with 
other apps. It’s different. Let’s compare this screen to the settings screens of 
other iPhone applications:
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Motion X GPS settings screen, compared to the settings screens of other apps. 
(Click to enlarge.)

Noticed the difference? Being inconsistent with other products makes yours 
worse for two reasons:

1. Going against convention makes your application less intuitive. Over-
styled controls look different and require users to re-learn how they 
work.

2. It’s a waste of time and money. The resources you have spent to make 
your app look different, but not necessarily better, could have been 
used much more effectively.
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BREAKING CONVENTION MAKES YOUR APP LESS INTUITIVE

The more familiar the parts of your app are, the more intuitive the app will be 
for whoever uses it. If we recognize the parts, we will be able to learn how to 
use the whole faster. It’s like reading: knowing the alphabet and meanings 
of words allows us to “decode” books we haven’t seen before.

Here’s an example from the real world. Try to make the stop sign more 
“beautiful” and people will inevitably start dying:
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“Sign B, 2, ‘STOP,’ shall be used to notify drivers that, at the intersection where 
the sign is placed, they shall stop before entering the intersection and give way 
to vehicles on the road they are approaching.” Article 10 of 2006 road signs 
convention.
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In his paper Intuitive Equals Familiar (Communications of the ACM. 37:9, 
September 1994, page 17), Jeff Raskin, an American human-computer 
interface expert best known for starting the Macintosh project for Apple 
Computer in the late 1970s, writes:

“The impression that the phrase ‘this interface feature is intuitive’ leaves is that 
the interface works the way the user does, that normal human ‘intuition’ suffices 
to use it, that neither training nor rational thought is necessary, and that it will feel 
‘natural.’”

However,

“… it is clear that a user interface feature is ‘intuitive’ insofar as it resembles or is 
identical to something the user has already learned. In short, “intuitive” in this 
context is an almost exact synonym of ‘familiar.’”
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Drastically re-designing every user interface element will make your 
application less intuitive, which will lead to more user mistakes and a longer 
learning curve. Eventually, you will lose customers because of it.

WHAT ABOUT BRANDING?

Is there place for branding in applications that are strictly following general 
design guidelines and usability conventions? Definitely! It is possible to 
strike a balance between having a unique look but not over-designing. 
Here’s one example:
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Let’s take a look at an example of overdesigning by Bloomberg. Here, we 
have an over-designed text input field at the top. You can barely recognize 
this as a field when you first look at it. The version on the right hand side is 
much better. A standard input field makes the screen’s purpose much 
clearer, while remaining consistent with the application’s style and branding.

Larger version.
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Here is another example by iFitness. Users are supposed to enter their 
weight day by day on this screen. But you have to flip through the months 
and days with a horizontal swipe to find the right one, and then you have to 
enter your weight digit by digit using five separate scroll fields. And then you 
have to press the very modest “Record” button, which you miss at first 
anyway and only find the hard way: after you have lost data. Much better:

Larger version.
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99.9% of users will want to enter today’s weight. This redesigned interface 
has one-quarter of the controls. The screen space that has been saved can 
now be used to present useful information, such as weight statistics. Date 
and time can be recorded automatically, and the selection of the metric or 
imperial system of measurement, which is not terribly important, has been 
demoted to a settings screen.

The Yellow Pages app uses tabs, which work well on the Web, but standard 
toggle controls are more familiar to iPhone users.

Larger version.
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WASTE OF TIME AND MONEY

Apple has already done an excellent job of creating standardized controls. 
Losing some of that functionality is almost guaranteed if you try to reinvent 
the wheel.

Back to our earlier example:
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If we take a closer look, we’ll see that one-third of the screen space we 
would have had is now lost because of over-designing.
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iPhone OS 3.0 introduced accessibility features. One of the modes is White 
on Black. Here’s what happens to our controls after inverting colors:

In the original control, color, shape and text survived color inversion. 
However in re-designed one, 2/3 of original meaning is lost. Now there is 
only text.

In sum, this redesign has given us twice as many UI elements, taking up 
twice as much real estate. The catch is, even if you haven’t made the 
controls worse, you still haven’t added much value and you have lost time 
and money in the process.

THAT TIME AND MONEY COULD HAVE BEEN SPENT ON…

Design is all about solving problems. Sometimes, when people don’t know 
exactly what problem they are solving, they wander in the design process, 
and the result is over-designed. To avoid that, you must have a clear picture 
of the problem you need to solve.

One of the best ways to get that picture is to talk to your users (both current 
and potential). Only when you know your customers’ needs will you be able 
to build an application they’ll love.

Don’t overdesign. Be sure your house has a solid foundation before you 
decorate it. You will be rewarded with more loyal customers and higher 
download rates surprisingly quickly.
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(Hopefully) coming soon: #2 iPhone’s Technological Limitations. What Apple 
hasn’t told you.
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iPhone Apps Design Mistakes: Disregard 
Of Context
Alex Komarov

The iPhone will always be part of a much bigger picture. How well you 
address human and environmental factors will greatly determine the 
success of your product. All too often, iPhone developers create products in 
isolation from their customers. In order to create really appealing 
applications, developers must stop focusing only on the mechanisms of the 
apps. Zoom out: understand the person using the application, as well as the 
complex environmental factors surrounding that person.

To better understand the context of these design challenges, we’ll highlight 
several levels of human and environmental factors.
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Level 1: You Are Here. To Create An App !at 
Customers Love, Zoom Out
Level 1: The app itself.
This is how many developers view their apps. As a developer, you have a 
vision of what your product should look like and why customers will turn 
their attention to it. However, if you observe your product so closely, you 
may put it in the wrong context and design it for the wrong purposes and for 
the wrong users. This is why you need to zoom out.
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Level 2: A person is using this app.
That person has specific goals and challenges. In the section below we’ll 
start by exploring some of the most prominent — and most ignored — 
human factors pertaining to the iPhone. We’ll discuss basic physical 
ergonomics, visual limitations and common design mistakes.
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Level 3: That person is using this app in a specific environment.
Step back and you’ll see that the app is a part of a complex social 
environment. It plays but a relatively small role in communication between 
people and helping people accomplish bigger goals. This is where the social 
components comes into play: networking, community, social-driven websites 
and applications and many other things create the environment — or the 
context — in which the application will be used.
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Level 4: The environment is part of a greater culture.
Your ability to address the unique needs of different cultures will affect the 
success of your product. Ignoring them is too expensive, especially if your 
app sells worldwide. Here it is important to understand that the environment 
is a part of global networking. You need to be aware of cultural differences, 
traditions and metaphors in order to create an application that will not only 
gain popularity in certain local circles, but will also have a global success.

Smashing eBook #30│Designing for iPhone│ 119



Level 2: Understand !e Person’s Needs And 
Limitations

“Measure twice and cut once”: an effective strategy indeed. For you, the 
iPhone app developer, this means that you have to step back and answer 
these questions before you start coding:

• Who will be using your application?

• What are the capabilities of that person?

• What are the limitations of that person?
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Answering these questions will broaden your perspective and prepare you 
to address your customer’s needs. A whole Human Factors profession is 
dedicated to just that.

BASIC PHYSICAL ERGONOMICS

Here are a couple of the most important physical-, cognitive- and 
ergonomic-related truths about the iPhone.

1. Our fingers are not mouse pointers.
Remember this property of our fingertips: their surface area is not equal to 
one pixel. In many applications, tappable objects are way too small, making 
the interface frustrating to use. Here’s one example: in iFitness, different 
muscle groups are indicated with red pins. Tapping a pin brings up the name 
of that muscle. And if you tap the name, you get a list of exercises that 
develop that muscle.
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The pins are twice as small as those used in the Google Maps app. Tapping 
the pin you want is very hard, because the surface of your fingertip covers 
an area of three or more pins. You end up tapping repeatedly on the area, 
enabling random pins, wishing you could sharpen your finger. After more 
than a few tries, you get lucky and hit the right one.

Which of these pins will be activated when you tap on it?

Here are some ways to solve these ergonomic challenges:

1. Make buttons and other tappable objects bigger.

2. If making a button bigger is impossible, then enlarge the clickable area 
to be bigger then the button itself.

3. Reduce the number of options on each screen, and make the selection 
process sequential (e.g. Arm Muscles → Biceps).
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4. Implement multi-touch gestures within the interface. For example, 
selecting a muscle group in iFitness would be made easier by 
introducing a two-finger zoom feature.

2. We’re not superheroes, unfortunately.
App designers need to take vision limitations into account. Mobile phones 
tend to be used in places with worse lighting conditions than computers. 
Think about those people who will be using your app on a bumpy bus or 
train or walking down a sunny street. Even if the technology is useful and 
perfectly executed, people will be reluctant to use the app if they find it hard 
to see what’s going on. Here are a few examples of potentially useful apps 
that do not account for vision limitations.
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TweetDeck
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Fish-tycoon

Here are some ways to avoid these mistakes:

1. Choose only the elements that are absolutely necessary. Make them 
bigger, and get rid of everything else. If needed, create additional 
screens with fewer options.

2. Remember that pixel dimensions on the iPhone are smaller than those 
on your computer screen. So, screenshots viewed on your computer’s 
iPhone emulator look larger than they would on the iPhone itself, even 
though the resolution is the same.
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The author holds an iPhone (163 ppi) in front of Apple Cinema’s 30-inch display 
(~100 ppi). Your iPhone screen layout may look fine on a computer emulator, but 
don’t be fooled: it will appear much smaller on the iPhone because of its smaller 
pixel dimensions.
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Level 3: Understand !e Challenges Specific To !e 
User’s Environment

GOALS AND ENVIRONMENT

Your app will usually play a relatively small role in helping the user achieve a 
bigger goal. The better you understand what goals people have and what 
they need to achieve them, the better you can design your app to satisfy 
those needs. Mobile phones are often used in loud, distracting 
environments. A simple stroll through town brings plenty of noisy 
distractions (cars, dogs, mail carriers, etc.). Consider the following examples. 
Which voice memo app would do a better job?
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Apple Voice 
Memos

vs. iTalk

Although Apple Voice Memos looks nice, iTalk addresses the average user’s 
goals and environment much better. Think about it: why would someone 
prefer to record a voice memo over writing a note? The audio format has 
fewer advantages than simple text. You can’t scan, edit or enhance audio 
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files as easily as you can text. In most scenarios, text is a much more 
convenient format in which to exchange information.

So, why and, more importantly, when would people use voice memos? 
When they are not able to type. The most common time is probably while 
driving.

According to the New York Times‘ summary of the Virginia Tech 
Transportation Institute‘s findings, drivers who text have a 23-times greater 
risk of a collision than drivers who don’t text. Which application would be 
easier to use in this case? The one with the big shiny mic and the record 
button that is small and hard to reach (especially for right-handed people)? 
Or the one with the red record button half the size of the screen? Certainly 
the latter.

Confirming for the user that the recorder is activated is important, too. Which 
interface communicates the device’s status more clearly? Where do you tap 
when you’re done?
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Apple Voice 
Memos

vs. iTalk

Based on which design works better overall, iTalk wins. Apple Voice Memo 
looks great when you’re checking it out on a friend’s phone but performs 
poorly in a real-world context.
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MOBILE PHONES, NETWORKING AND COMMUNITY

The mobile phone is, without a doubt, a social tool. The greater the number 
of people involved, the more engaging the experience is. Think about it: if 
you were the only one with a phone, it wouldn’t be very useful. YouTube, 
Facebook and Twitter are driven by the understanding that we are social 
beings — we want to share! Imagine how dramatically designs that foster 
greater social interaction could change the mobile world.

With the seemingly endless ways to capture and share information, many 
people feel overwhelmed with information. To help them cope, designers 
must exploit the iPhone’s platform to make their applications as efficient as 
possible. Here are some inspiring examples:

Smashing eBook #30│Designing for iPhone│ 132



Bump
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“Bump makes swapping contact information and photos as simple as 
bumping two phones together. No typing, no searching a list for the right 
person, no mistakes.” (iTunes Store description)

Mover
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“Ever wished you could send something to the iPhone right next to you? Do 
it with style with Mover.”

Check the video

Loopt
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“Loopt transforms your mobile phone into a social compass to discover and 
navigate the world around you. Use Loopt to see who’s around, what to do, 
and where to go.”

How Loopt works (video):

Level 4: !e Environment Is Part Of A Greater 
Culture.
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Your ability to address the unique needs of different cultures will affect the 
success of your product. Ignoring them is too expensive, especially if your 
app sells worldwide. Design should adapt to regional challenges. Jacob 
Nielsen, a leading usability expert, gives us an illustration of this:

“In Sweden, the Automatic Teller Machines have very large buttons. I hadn’t 
noticed this particular design element on previous visits, which have usually been 
in warmer months. In 1996 I was in Stockholm in February and immediately 
realized why the ATM buttons are so big: you can press them wearing thick 
gloves.”

Such insights are gained only by understanding the product in its real-world 
context. Here is the graphic designer’s point of view:

“… Understanding the object in context moves graphic design from a purely 
formal arena to a social and political one.”
—Steven Heller and Karen Pomeroy in “Design Literacy,” Allworth Press, New 
York, 1997.

More wisdom from Nielsen:

“A system must match the user’s cultural characteristics. This goes beyond simply 
avoiding offensive icons; it must accommodate the way business is conducted 
and the way people communicate in various countries.”
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Apple studied American users and addressed their goals. That’s why the 
iPhone is so popular in US. But it hasn’t succeeded in Japan. The handset is 
selling so poorly there that they are giving them away for free.

Conclusion: Excellence Comes From Hard Work
Designing a great app isn’t a simple task. Jacob Nielsen recently asserted 
that “the mobile user experience is still miserable.” Extracting user insights 
from testing is a challenge. People have difficulty telling you what they want; 
they usually only know it when they see it. But developers don’t have to 
tackle user research alone. Interaction designers are trained to find relevant 
user groups, talk to customers and read between the lines. They understand 
how real-world context affects an application’s design.

It takes a lot of leg work, but your efforts to understand user needs will be 
rewarded. The forefront of mobile technology is an exciting place to be.
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Se"ing Up Photoshop For Web, App and 
iPhone Development
Marc Edwards

Most people who have designed websites or apps in Photoshop will, at one 
point or another, have had issues trying to match colors in images to colors 
generated by HTML, CSS or code. This article aims to solve those problems 
once and for all.

Color Management to Match Colors Across Multiple 
Devices
In the print world, color management typically involves calibrating your 
entire workflow, from scanner or digital camera to computer display to hard 
proofs to the final press output. This can be quite a tall order, especially 
when the devices use different color spaces — matching RGB and CMYK 
devices is notoriously hard.

When designing or editing for TV, calibrating the main editing display and 
using a broadcast monitor are common; these show real-time proof of how 
the image will look on a typical TV in a viewer’s home. In such a scenario, 
color management offers many benefits and is highly recommended.

When building Web and application interfaces, the situation is a little 
different. The final output is the same device that you’re using to create the 
artwork: a computer display (putting aside for now differences in gamma 
between Windows, OS X prior to 10.6 and the iPhone, which we’ll cover 
later.)
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There is a catch, though. Even though you’re creating the Web or app 
interface on the same device that the final product will be shown on, the 
colors will have various sources: images (typically PNG, GIF and JPEG), style 
markup (CSS) and code (JavaScript, HTML, Objective-C, etc). Getting them 
all to match can be tricky.

THE GOAL

When designing websites or app interfaces, we want to perfectly match the 
colors that are displayed on screen in Photoshop and that are saved in files 
with what’s displayed in other applications, including Firefox, Safari and the 
iPhone Simulator. Not only do we want the colors to look the same, but we 
want the actual values saved in the files to perfectly match the colors we 
have defined in Photoshop. Colors should not shift or appear to shift in any 
way, under any circumstance.
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WHY IS THIS SO DIFFICULT?

Photoshop applies its color management to images displayed within its 
windows and to the files it saves. This is a bad thing if you’re working 
exclusively with RGB images for Web or on-screen user interfaces. With the 
default Photoshop settings, #FF0000 will actually display as #FB0018, and 
#BB95FF will display as #BA98FD. The differences are subtle but definitely 
there.

How Does Photoshop Differ From OS X And Windows?

OS X’s color management is applied to the entire display at the very end of 
the processing chain, after the main buffer in video ram. This means that 
although color management is applied, the software utilities that measure 
color on screen (like /Utilities/DigitalColor Meter) will report the same values 
that you have saved in the file or entered as your code. I believe the color 
management in Windows Vista and Windows 7 (Windows Color System) 
works in a similar fashion.
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Photoshop’s color management is applied only to the image portion of its 
windows and to the files it saves. This color correction happens as 
Photoshop draws the image on screen, so software utilities that measure 
color on screen often report different colors from the ones you have 
specified. It’s worth noting that OS X’s color management is applied on top 
of Photoshop’s.

The best solution I’ve found is to disable Photoshop’s color management for 
RGB documents as much as possible. Doing so forces the RGB colors that 
are on screen and saved to the file to match the actual color value. If you 
need to calibrate your monitor for Web and app design work, then you 
would best be served by changing it at the OS level.

Disabling color management used to be quite easy in Photoshop CS2 and 
all versions prior, but it now requires a little more skill.

Disabling Photoshop’s RGB Color Management
These instructions are for Photoshop CS4 on Mac and Windows. Setting up 
CS3 is very similar.

Step 1: Go to Edit → Color Settings and set the working space for RGB to 
Monitor RGB.
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Step 2: Open a document and go to Edit → Assign Profile, then set it to Don’t 
Color Manage This Document. This must be done for every single document 
you work on.

Step 3: Ensure View → Proof Colors is turned off.

Step 4: When saving files with Save for Web & Devices, ensure that Convert 
to sRGB is turned off. If you’re saving a JPEG file, then also turn off Embed 
Color Profile (you may want this turned on for certain photos, but chances 
are you’ll want it off for interface elements and icons).
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Difference Between “Assign Profile” And “Convert To 
Profile”
Now would be a good time to mention the difference between Assign Profile 
and Convert to Profile, so that you know which to use when.

Each Photoshop document contains a color profile that’s separate from the 
actual color data stored for each pixel. Assign Profile simply changes the 
profile in the document, without affecting any of the color data. It’s a non-
destructive action: you can assign a new color profile to your documents as 
often as you like without doing any damage. Assigning a new profile may 
change the way your document appears on screen, but the data contained 
in the file will remain unaltered.

Convert to Profile is quite different. Not only does it assign a color profile to 
the document, but it tries to keep your image looking the same on screen. It 
does this by processing the color data contained in the file for each pixel. 
Converting to a new profile will more likely preserve a document’s color on 
screen, but the data contained in the file will be permanently altered. Use 
with caution.

If you’re copying layers from one Photoshop document to another, you will 
want to ensure that the documents have been assigned the same color 
profile.

Illustrator Is !e Same As Photoshop
If you would like images saved in Illustrator or imported from Illustrator to 
Photoshop to match as well, then follow the steps below. These instructions 
are for Illustrator CS4 on Mac and Windows. Setting up Illustrator CS3 is very 
similar.
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Step 1: Go to Edit → Color Settings, and set the working space for RGB to 
Monitor RGB.
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Step 2: Open the document and go to Edit → Assign Profile. Then set it to 
Don’t Color Manage This Document. This must be done for every single 
document you work on.
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Step 3: Ensure that View → Proof Colors is turned off.

Step 4: When saving files with Save for Web & Devices, ensure that Convert 
to sRGB is turned off. If you’re saving a JPEG file, then also turn off Embed 
Color Profile (again, you may want this turned on for certain photos, but 
chances are you’ll want it off for interface elements and icons).
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Gamma Differences
Windows has used a gamma of 2.2 since its introduction. OS X has used a 
gamma of 1.8 for all versions except Snow Leopard (the latest release), 
which uses 2.2. What does this mean? Prior to Snow Leopard, Web pages 
looked darker on Windows. Thankfully, both operating systems are now in 
sync, so a Web page should look very similar on a Mac and PC that use the 
same monitor.

Information about the iPhone’s gamma is a little hard to come by; I couldn’t 
ascertain whether it is 1.8 or 2.2. This is another reason to test your interface 
on an iPhone.

Final Check For iPhone UI
Your iPhone or iPod’s screen and calibration will likely be different from your 
Mac or PC’s screen and calibration. I often import full-screen images of the 
UI into iPhoto and sync them with an iPhone to see exactly how the final 
interface will look on the device (on Windows, you can sync photos using 
iTunes). This gives you another chance to make adjustments before slicing 
up images or committing anything to code.
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This article explains how to handle the problem that while testing some 
landscape iPhone app interface mocks, they seem blurrier than they appear in 
Photoshop.
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On Mac, moving colors between Photoshop and code can be made easier 
with Developer Picker, Hex Color Picker and Colors (all free).

Conclusion
Now, you’re able to move bitmap and vector images between Photoshop 
and Illustrator without any color shifts at all, and using any method. You’re 
also able to grab a color using the color picker in Photoshop, and then use 
the same HEX color value in your CSS, HTML, JavaScript, Flash or Objective-
C code, and it will match your images perfectly.
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Designing For iPhone 4 Retina Display: 
Techniques And Workflow
Marc Edwards 

The iPhone 4 features a vastly superior display resolution (614400 pixels) 
over previous iPhone models, containing quadruple the 153600-pixel display 
of the iPhone 3GS. The screen is the same physical size, so those extra dots 
are used for additional detail — twice the detail horizontally, and twice 
vertically. For developers only using Apple’s user interface elements, most 
of the work is already done for you.

For those with highly custom, image-based interfaces, a fair amount of work 
will be required in scaling up elements to take full advantage of the iPhone 4 
Retina display. Scaling user interfaces for higher detail displays — or 
increasing size on the same display — isn’t a new problem. Interfaces that 
can scale are said to have resolution independence.

In a recent article, Neven Mrgan described resolution independence: “RI 
[resolution independence] is really a goal, not a technique. It means having 
resources which will look great at different sizes.” If it’s a goal, not a specific 
technique, then what techniques exist? How has Apple solved the problem 
in iOS?

While apps that take advantage of Apple’s native user interface elements 
require a lot less work when designing for the Retina display, we’re here to 
talk about highly custom, graphic-driven apps that need a fair amount of 
work to take full advantage of the Retina display.
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While not strictly a resolution-independent technique, using a fluid layout 
can help an app grow to take advantage of a larger window or screen by 
adding padding or by changing the layout dynamically. A lot of Mac, 
Windows and Linux apps use this method, as do some websites.

This is partially how Apple handled the difference in resolution from iPhone 
to iPad — a lot of UI elements are the same pixel size, but padded to make 
use of the extra screen real estate. The status bar is a good example of this. 
It works because the pixel densities of the iPhone 3GS and iPad are similar 
(163 ppi vs 132 ppi).

Full view
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Fluid layouts work when the change in density is minor, but aren’t any help 
with the iOS non-Retina to Retina display transition (163 ppi to 326 ppi). The 
image below demonstrates what would happen if an iPhone app was simply 
padded to cater for the higher resolution display of the iPhone 4. Buttons 
and tap areas would be the same size in pixels, but half the physical size 
due to the higher pixel density, making things harder to read and to tap.

Full view
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Just-in-time Resolution Independence
Another approach to handling widely different resolutions and pixel 
densities is to draw everything using code or vector-based images (like 
PDFs) at runtime. Without trying to stereotype anyone, it’s usually the 
approach engineering-types like. It’s clean, simple and elegant. It lets you 
design or code once, and display at any resolution, even at fractional scales.

Unfortunately, using vector-based images tends to be more resource-hungry 
and lacks pixel level control. The increase in resources may not be an issue 
for a desktop OS, but it is a considerable problem for a mobile OS. The lack 
of pixel level control is a very real problem for smaller elements. Change an 
icon’s size by one pixel, and you will lose clarity.
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Neven emphasizes in his article that:

“…it is simply not possible to create excellent, detailed icons which can be 
arbitrarily scaled to very small dimensions while preserving clarity. Small icons 
are caricatures: they exaggerate some features, drop others and align shapes to 
a sharp grid. Even if all icons could be executed as vectors, the largest size would 
never scale down well.”
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Although here he is talking exclusively about icons, his description is apt for 
most UI elements. The decisions involved in scaling are creative, not 
mechanical. Vector-based elements aren’t suitable for all resolutions, if you 
value quality.

Ahead-of-time Resolution Independence
The best quality results — and the method Apple chose for the iPhone 3GS 
to iPhone 4 transition — comes from pre-rendered images, built for specific 
devices, at specific resolutions: bespoke designs for each required size, if 
you will. It’s more work, but pre-rendering images ensures everything always 
looks as good as possible.

Apple chose to exactly double the resolution from the iPhone 3GS to the 
iPhone 4, making scaling even easier (different from the approach of Google 
and Microsoft — notice that this article is not relevant to the latest version of 
Microsoft’s mobile OS — proving yet again that controlling the entire stack 
has huge advantages).
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Currently, there are three iOS resolutions:

• 320 × 480 (iPhone/iPod touch)

• 640 × 960 (iPhone 4 and iPod with Retina display)

• 768 × 1024 / 1024 × 768 (iPad)

In a few years, it seems highly likely that the line-up will be:

• 640 × 960 (iPhone/iPod touch with Retina display)

• 1536 × 2048 / 2048 × 1536 (iPad with Retina display)

• Some kind of iOS desktop iMac-sized device with a Retina display
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There are significant differences between designing iPhone and iPad apps, 
so completely reworking app layouts seems necessary anyway — you can’t 
just scale up or pad your iPhone app, and expect it to work well or look 
good on an iPad. The difference in screen size and form factor means each 
device should be treated separately. The iPad’s size makes it possible to 
show more information on the one screen, while iPhone apps generally 
need to be deeper, with less shown at once.

Building Designs !at Scale
Building apps for the iPhone 4 Retina display involves creating two sets of 
images — one at 163 ppi and another at 326 ppi. The 326 ppi images 
include @2x at the end of their filename, to denote that they’re double the 
resolution.

When it comes to building UI elements that scale easily in Adobe 
Photoshop, bitmaps are your enemy because they pixelate or become blurry 
when scaled. The solution is to create solid color, pattern or gradient layers 
with vector masks (just make sure you have “snap to pixel” turned on, where 
possible). While a little awkward at times, switching to all vectors does have 
significant advantages.

Before anyone mentions it, I’m not suggesting any of the methods are new; 
I’m willing to bet that most icon designers have been working this way for 
years. I’ve been using vector shapes for ages too, but the Retina display has 
changed my practice from using vector shapes only when I could be 
bothered, to building entire designs exclusively with vector shapes.
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I usually draw simple elements directly in Photoshop using the Rectangle or 
Rounded Rectangle Tool. Draw circles using the Rounded Rectangle Tool 
with a large corner radius, because the ellipse tool can’t snap to pixel. Layer 
groups can have vector masks too, which is handy for complex compositing 
(option-drag a mask from another layer to create a group mask).

Full view
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More complex objects get drawn in Adobe Illustrator to the exact pixel size, 
and then pasted into Photoshop as a shape layer. Be careful when pasting 
into Photoshop, as the result doesn’t always align as it should — it’s often 
half a pixel out on the x-axis, y-axis or both. The workaround is to zoom in, 
scroll around the document with the Hand Tool, and paste again. Repeat 
until everything aligns. Yes, it’s maddening, but the method works after a 
few attempts. Another option is to zoom in to 200%, select the path with the 
Direct Selection Tool, and nudge once, which will move everything exactly 
0.5px.

Full view
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Even more complex objects requiring multiple colors get drawn in Illustrator 
to the exact pixel size, and then pasted into Photoshop as a Smart Object. It 
is a last resort, though — gradients aren’t dithered, and editing later is more 
difficult.

If you need to use a bitmap for a texture, there are three options: use a 
pattern layer, a pattern layer style, or build a bitmap layer at the 2× size and 
turn it into a Smart Object. I prefer to use pattern layer styles in most cases, 
but be warned: patterns are scaled using bicubic interpolation when you 
scale the entire document, so they become “softer.” The solution is to create 
two versions of each pattern, then to manually change pattern layer styles to 
the correct pattern after scaling — a little tedious, but totally do-able 
approach.
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Full view
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Scaling Up
At this point, your document should be able to scale to exactly double the 
size, without a hitch.
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I have a Photoshop Action set up that takes a History Snapshot, then scales 
to 200%. That means, previewing at the Retina display’s resolution is only a 
click away. If you’re feeling confident you’ve built everything well, you 
should be able to scale up, edit, then scale down and continue editing 
without degradation. If you run into trouble, a Snapshot is there to take you 
back. Using one document for both resolutions, means not having to keep 
two documents in sync — a huge advantage.
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A word of warning: layer styles can only contain integer values. If you edit a 
drop shadow offset to be 1 px with the document at 2× size, and then scale it 
down, the value will end up as 1 px because it can’t be 0.5 px (a non-integer 
value). If you do require specific changes to the 2× version of the Photoshop 
file, you’ll have to save that version as a separate file.

Exporting, Exporting, Exporting
Now for some bad news: exporting all the images to build an app can be 
extremely tedious, and I don’t have much advice here to assist you. As my 
documents act as full screen mockups, they’re not set up in a way that 
Photoshop’s Slice feature is any use. Layer comps don’t help either — I 
already have folders for each app state or screen, so switching things off 
and on is easy.

The best export method seems to be: enable the layers you’d like visible, 
make a marquee selection of the element, then use Copy Merged and paste 
the selection into a new document — not much fun when you have 
hundreds of images to export.

The problem is amplified when saving for the Retina display, where there 
are twice as many images and the 1× images must match the 2× images 
precisely.
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The best solution I’ve come up with so far:

• Build your design at 1×

• Use Copy Merged to save all the 1× images

• Duplicate the entire folder containing the 1× images

• Use Automator to add @2x to all the filenames

• Open each @2x image and run the “Scale by 200%” Photoshop action. 
This gives you a file with the correct filename and size, but with 
upscaled content

• Scale your main Photoshop design document by 200%

• Use Copy Merged to paste the higher quality elements into each @2x 
document, turn off the lower quality layer, then save for the Web, 
overwriting the file.

In some cases, Photoshop’s “Export Layers To Files” can help. The script 
can be found under the File menu.
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Mac Actions and Workflows
All the Actions and Workflows that I use myself can be downloaded from the 
blog post link below. The Automator Workflows can be placed in your Finder 
Toolbar for quick access from any Finder window, without taking up any 
space in your Dock.

Download: Retina Actions and Workflows.zip

Fortunately, Apple chose to exactly double the resolution for the iPhone 4, 
and for using ahead-of-time resolution independence. As complex as the 
process is now, things would have been far worse if they had chosen a 
fractional scale for the display.
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Showcase Of Designs Optimized For 
iPhone
Adeel Raza

Over the last couple of years, mobile devices have managed to gain 
mainstream popularity. With iPhone, making mobile Web applications finally 
usable by broad masses, web design can now be applied to mobile 
applications as well. In this article we are focusing on designs that are 
specifically optimized for mobile devices, in particular iPhone.

Though iPhone’s Safari browser is able to render any website just like you 
would see it on a desktop browser, the available screen area is much 
smaller than in common “classic” displays. This poses a new challenge for 
designers and developers who now can reach millions of users that use 
mobile Web. Websites that are specifically optimized for the iPhone utilize 
the screen to the fullest extent, and use less bandwidth (which is necessary, 
because the connectivity is not always optimal).

The iPhone browsing experience is quite different than the regular browsing 
experience. The buttons and hyperlinks have to be bigger because our 
fingers are not as sharp as the mouse pointer. Optimizing a website for 
iPhone is not rocket science. It’s the same HTML, CSS and JavaScript that 
you already know. The only major difference is the screen size.

In the showcase below we present some of the interesting, interactive and 
beautiful designs that are optimized for the iPhone. You will also learn about 
some handy tools that will help you optimize your website for the iPhone.
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1. News / Entertainment
Sevnth Sin
The unique navigation makes this site very interactive. Nice concept, nice 
colors.
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Blip.tv
Perfectly suits the theme: video entertainment! Clean and clear typography.
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NBC
The YouTube-style design makes it very easy to navigate and find shows.
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Zinio
That’s a kit of magazines, all one-touch away!
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Spin The Bottle
A simple bottle spinning game. Good use of graphics.
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Daily Wallpaper
Similar to Zinio, but 2 thumbnails in a row make it more easy to navigate 
around.
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AOL Horoscopes
Very well designed for a horoscope site. Matching color scheme throughout.
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Yahoo Omg!
Fresh look, vibrant colors and lively typography make this design fun to 
browse and easy to read. The design also matches the celebrity gossip 
theme.
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2. Business / Corporate
DPTO
Different tones of red make this design look very attractive on the iPhone. 
The 3D menu looks very nice — perfect for a marketing and design agency.
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Mind Medium Creative
The use of gradients make the overall site look very shiny on the iPhone. 
The menu is very to-the-point. A nice composition and execution.
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Redhawk Investment Advisors
This design has a very corporate feel to it. Good use of colors.
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Showcase Of Designs Optimized For iPhone - Part II

Nike Lab
Just what to expect from Nike. Sporty and energetic design.
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Procab Studio
Procab studio showcases their work portfolio and other information about 
the agency. Well placed content. The font size is a bit too small, though.
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Hotel Monterilla
The design makes you want to go there for a vacation. The design has a 
very comforting feel to it. A perfect color scheme.
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Viget Labs
A blue background, appropriate padding and rounded corners make this 
simple design look vibrant and attractive.
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Batali Associates
This is one of the good examples of design optimization for the iPhone. It 
clearly looks like it was really made for the iPhone, not just duplicated.
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Ready For iPhone
A company that provides iPhone optimized website solutions. The finger on 
the “Go” looks intuitive.
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Element Fusion
Another showcase website that provides design services. Looks like a cut-
down version of the actual website.
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Volkswagon
A showcase gallery for Volkswagon. Easy to navigate around. Clean and 
clear content.
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3. Shopping / E-Commerce
Torn Robes
A nice example of a mobile e-Commerce site. Just touch your favourite 
design, have a look at it and buy it. Looks very vibrant.

Smashing eBook #30│Designing for iPhone│ 207

http://tornrobes.com/
http://tornrobes.com/
http://tornrobes.com/
http://tornrobes.com/


Smashing eBook #30│Designing for iPhone│ 208

http://tornrobes.com/
http://tornrobes.com/


Coosh
A single-product e-Commerce site. Branded very well.
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Walmart
This design doesn’t really meet the expectations from WalMart — however, 
the design is still in beta. The usability is good, though: it is very easy to 
search for products and stores. You can also create shopping lists.
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4. Portfolio / Blog
World Ending Blog (Japanese)
Although we did not understand a word there, it is very well designed for the 
iPhone. Every page is optimized and provides a good browsing experience.
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Signal Element
Simple and clean design: just 3 pages, but very well designed.
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One Crimson Splash
This is the portfolio of James Finley. The choice of colors and content 
placement are very good.
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5. Education / Content
MIT
What else to expect from MIT? Simple, clean, user-friendly.
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101 Cook Books
Not really a fancy design, but it’s the simplicity and clarity of content that 
makes it appear in this showcase.
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Please Fix The iPhone
A good design that provides the desktop browsing experience. It is very 
easy to find what you are looking for.
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1881
The Norwegian telephone directory online. The combination of bright blue, 
orange and white looks really good.
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AOL Food
Heaven for those who love to cook. Just keep your iPhone with you in the 
kitchen, and let this nice design help you make a delicious dinner.
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Deviant Art
A nice way to browse art on the iPhone. The color scheme is good, and it 
makes the artwork look prominent. Very easy to navigate and search. Also, 
appropriately sized thumbnails.
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Last but not least, some words of wisdom…

Tools to design a website for iPhone
There are some libraries and kits available to help you iPhoneize your 
design.

• iPhoney
iPhoney gives you a pixel-accurate web browsing environment—
powered by Safari—that you can use when developing web sites for 
iPhone. It’s a perfect tool to see how your web creations will look on 
iPhone.
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• Test iPhone
A web browser based simulator for quickly testing your iPhone web 
designs.

• iWebKit (Demo)
iWebKit is a file package designed to help you create your own iPhone 
and iPod Touch compatible website or webapp. Comes with various 
ready-to-use themes.

• iUI
iUI is a framework consisting of a JavaScript library, CSS, and images for 
developing iPhone web designs. It makes your web designs look and 
feel like iPhone’s native applications.

• Intersquash (Demo)
Not really a helpful tool for designing, but you can instantly create an 
iPhone compatible site from your RSS feed url.

• WPtouch
For WordPress users: WPtouch transforms your WordPress blog into an 
iPhone application-style theme, complete with ajax loading articles and 
effects, when viewed from an iPhone or iPod touch.

• Jaipho Gallery (Demo)
If your website features a photo gallery, Jaipho will optimize it for 
iPhone users.
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